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Preface 

 

This User Guide has been implemented by Boot & Work, S.L. working 

under the name Industrial Shields.  

 

Purpose of the manual 

The information contained in this manual can be used as a reference to operating, to 
functions, and to the technical data of the signal modules, power supply modules and 
interface modules.  

 

Intended Audience 

This User Guide is intended for the following audience: 

• Persons in charge of introducing automation devices. 

• Persons who design automation systems. 

• Persons who install or connect automation devices. 

• Persons who manage working automation installation. 

 

 

   Warnings: 

 

• Unused pins should not be connected. Ignoring the directive may damage the 

controller. 

• Improper use of this product may severely damage the controller. 

• Refer to the controller’s User Guide regarding wiring considerations. 

• Before using this product, it is the responsibility of the user to read the product’s User 

Guide and all accompanying documentation. 

• Maintenance must be performed by qualified personnel familiarized with the 

construction, operation, and hazards involved with the control.  

•  Maintenance should be performed with the control out of operation and 

disconnected from all sources of power.  

• Care should be taken when servicing electrostatic sensitive components. The 

manufacturer's recommendations for these components should be followed.  

• The ESP32 ETHERNET&WIFI&BLUETOOTH PLCFamily PLCs are Open Type Controllers. It 

is required that you install the ESP32 ETHERNET&WIFI&BLUETOOTH PLCPLC in a 
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housing, cabinet, or electric control room. Entry to the housing, cabinet, or electric 

control room should be limited to authorized personnel. Failure to follow these 

installation requirements could result in severe personal injury and/or property 

damage. Always follow these requirements when installing ESP32 

ETHERNET&WIFI&BLUETOOTH PLC family PLCs. 

• In case of installation or maintenance of the ESP32 ETHERNET&WIFI&BLUETOOTH PLC 

please follow the instructions marked in the Installation and Maintenance section. 

• Do not disconnect equipment when a flammable or combustible atmosphere is 

present. Disconnection of equipment when a flammable or combustible atmosphere is 

present may cause a fire or explosion which could result in death, serious injury and/or 

property damage. 

 

 

   Avertissements: 

 

• Les broches non utilisées ne doivent pas être connectées. Ignorer la directive peut 

endommager le contrôleur. 

• Une utilisation incorrecte de ce produit peut endommager gravement le contrôleur. 

• Reportez-vous au Guide de l’utilisateur du contrôleur pour les considérations de 

câblage. 

• Avant d’utiliser ce produit, il incombe à l’utilisateur de lire le Guide de l’utilisateur du 

produit et la documentation qui l’accompagne. 

• La maintenance doit être effectuée par personnel qualifié familiarisé avec la 

fabrication, le fonctionnement et les dangers liés au contrôleur. 

• La maintenance doit être effectuée avec l’équipement hors service et déconnectée de 

toutes les sources d'alimentation. 

• Faites attention lors de l'entretien des composants sensibles à l'électricité statique. 

Les recommandations du fabricant pour ces composants doivent être suivies. 

• Les automates de la famille ESP32 ETHERNET&WIFI&BLUETOOTH PLCsont des 

contrôleurs de type ouvert. Il est nécessaire d'installer l'automate ESP32 

ETHERNET&WIFI&BLUETOOTH PLCdans un boîtier, une armoire ou une salle de 

contrôle électrique. L'accès au boîtier, à l'armoire ou à la salle de commande 

électrique doit être limité au personnel autorisé. Le non-respect de ces exigences 

d'installation peut entraîner des blessures graves et/ou des dommages matériels 

importants. Respectez toujours ces exigences lors de l'installation des automates de la 

famille ESP32 ETHERNET&WIFI&BLUETOOTH. 

• En cas d'installation ou de maintenance du ESP32 ETHERNET&WIFI&BLUETOOTH PLC, 

veuillez suivre les instructions indiquées dans la section Installation et Maintenance. 

• Ne débranchez pas l'équipement en présence d'une atmosphère inflammable ou 

combustible. La déconnexion de l'équipement en présence d'une atmosphère 
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inflammable ou combustible peut provoquer un incendie ou une explosion pouvant 

entraîner la mort, des blessures graves et/ou des dommages matériels. 

Application Considerations and Warranty 

Read and Understand this Manual 

Please read and understand this manual before using the product. Please consult your 

comments or questions to Industrial Shields before using the product. 

 

Application Consideration                               

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED. 

THEY SHOULD NOT BE RELIED UPON AS A SAFETY COMPONENT OR 

PROTECTIVE DEVICE FOR ENSURING SAFETY OF PERSONS, AS THEY ARE 

NOT RATED OR DESSIGNED FOR SUCH PURPOSES.  

Please know and observe all prohibitions of use applicable to the products.  

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY 

WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE HAS BEEN DESSIGNED 

TO ADDRESS THE RISKS, NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS.  

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE 

PROPERLY RATED AND INSTALLED FOR THE INTENDED USE WITHIN THE 

OVERALL EQUIPMENT OR SYSTEM.  

Industrial Shields shall not be responsible for conformity with any codes, regulations or 

standards that apply to the combination of products in the customer’s application or use 

of the product. 

The following are some examples of applications for which particular attention must be  

given. This is not intended to be an exhaustive list of all possible uses of the products, 

nor is it intended to imply that the uses may be suitable for the products: 

• Systems, machines, and equipment that could present a risk to life or property. 

• Nuclear energy control systems, combustion systems, railroad systems, 

aviation systems, medical equipment, amusement machines, vehicles, safety 

equipment, and installation subject to separate industry or government 

regulations. 

• Outdoor use, uses involving potential chemical contamination or electrical 

interference, or conditions or uses not described in this document. 

 

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third party 

certification documents identifying ratings and limitations of use that apply to the 

products. This information by itself is not sufficient for a complete determination of the 

suitability of the products in combination with the system, machine, end product, or 

other application or use. 
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Intended use or of Industrial Shields products                                                  

Consider the following: 

Industrial Shields products should only be used for the cases of application foreseen in 

the catalogue and the associated technical documentation. If third-party products and 

components are used, they must have been recommended or approved by Industrial 

Shields.  

The correct and safe operation of the products requires that your transport, storage, 

installation, assembly, operation and maintenance have been carried out in a correct It 

must respect the permissible ambient conditions. You should also follow the indications 

and warnings that appear in the associated documentation. 

The product / system dealt with in this documentation should only be handled or 

manipulated by qualified personnel for the task entrusted and observing what is 

indicated in the documentation corresponding to it, particularly the safety instructions 

and warnings included in it. Due to their training and experience, qualified personnel 

are in a position to recognize risks resulting from the handling or manipulation of such 

products / systems and to avoid possible hazards. 

Disclaimers             

Weights and Dimensions 

Dimensions and weights are nominal and they are not used for manufacturing 

purposes, even when tolerances are shown. 

Performance Data 

The performance data given in this manual is provided as a guide for the user in 

determining suitability and does not constitute a warranty. It may represent the result of 

INDUSTRIAL SHIELDS’s test conditions, and the users most correlate it to actual 

application requirements. Actual performance is subject to the INDUSTRIAL SHIELDS 

Warranty and Limitations of Liability. 

Errors and Omissions 

The information in this document has been carefully checked and is believed to be 

accurate; however, no responsibility is assumed for clerical, typographical, or 

proofreading errors, or omissions. 

The control and drive components of an Industrial Shields PLC are approved for 

industrial and commercial use in industrial line supplies. Their use in public line 

supplies requires a different configuration and/or additional measures. These 

components may only be operated in closed housings or in higher-level control 

cabinets with protective covers that are closed, and when all of the protective devices 

are used. These components may only be handled by qualified and trained technical 

personnel who are knowledgeable and observe all of the safety information and 

instructions on the components and in the associated technical user documentation. 
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When carrying out a risk assessment of a machine in accordance with the EU 

Machinery Directive, the machine manufacturer must consider the following residual 

risks associated with the control and drive components of a PDS.  

1. Unintentional movements of driven machine components during commissioning, 

operation, maintenance, and repairs caused by, for example: − Hardware defects 

and/or software errors in the sensors, controllers, actuators, and connection technology 

− Response times of the controller and drive − Operating and/or ambient conditions not 

within the scope of the specification − Condensation / conductive contamination − 

Parameterization, programming, cabling, and installation errors − Use of radio devices / 

cellular phones in the immediate vicinity of the controller − External influences / 

damage.  

2. Exceptional temperatures as well as emissions of noise, particles, or gas caused by, 

for example: − Component malfunctions − Software errors − Operating and/or 

ambient conditions not within the scope of the specification − External 

influences / damage. 

3. Hazardous shock voltages caused by, for example: − Component malfunctions − 

Influence of electrostatic charging − Induction of voltages in moving motors − Operating 

and/or ambient conditions not within the scope of the specification − Condensation / 

conductive contamination − External influences / damage  

4. Electrical, magnetic and electromagnetic fields generated in operation that can pose 

a risk to people with a pacemaker, implants or metal replacement joints, etc. if they are 

too close.  

5. Release of environmental pollutants or emissions as a result of improper operation 

of the system and/or failure to dispose of components safely and correctly. 
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Warranty and Limitations of Liability 

Warranty 

Industrial Shields’s exclusive warranty is that the products are free from defects in 

materials and workmanship for a period of one year (or other period if specified) from 

date of sale by Industrial Shields. 

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY, 

EXPRESSED OR IMPLIED, REGARDING MERCHANABILITY, NON-

INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE OF THE PRODUCTS. 

ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR USER ALONE 

HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE 

REQUIREMENTS OF THEIR INTENDED USE. INDUSTRIAL SHIELDS DISCLAIMS 

ALL OTHER WARRANTIES, EXPRESS OR IMPLIED 

 

Limitations of Liability 

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT, 

OR CONSEQUENTIAL DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN 

ANY WAY CONNECTED WITH THE PRODUCTS, WHETHER SUCH CLAIM IS 

BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR STRICT LIABILITY. 

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONISBLE FOR WARRANTY, 

REPAIR OR OTHER CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL 

SHIELDS’S ANALYSIS CONFIRMS THAT THE PRODUCTS WERE PROPERLY 

HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT SUBJECT TO 

CONTAMINATION, ABUSE, MISUSE, OR INAPPROPIATE MODIFICATION OR 

REPAIR. 
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 General Description ESP32 ETHERNET&WIFI&BLUETOOTH 

PLC FAMILY Product 

 

 

1.1 Zones Table 
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1.2 Measures Table 
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1.3 Zone - Nomenclature 

The nomenclature shown in this point will be used in the whole User Guide, so it is 

important to understand this nomenclature.  

The nomenclature to differentiate the zones is based on Alphanumeric values, being 0 

the internal communication shield and A, B or C the I/Os or Relay shield. 

 

  

 

 

 

 

 

 

● The inputs in the zone A/B/C are named IX.X, being X any number suitable in 
the Shield. Outputs are named as QX.X. 

 

1.4 Zone Distribution 

 

 

This is the possible zones scheme, whether the zone is Analog/Digital or Relay 

depends on your device, you can consult it on the Zones Table. The distribution of the 

different features that provide the Raspberry PLC Family are described below. 
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1.5 Zone Features 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Shield Zone Characteristics 

Communication Shield 

(1x) Ethernet 
(1x) WiFi 
(1x) BLE 
(1x) USB 
(1x) I2C 
(1x) RS-232 
(1x) HALF Duplex RS-485 
(1x) SPI external Port 
(1x) RTC 
(1x) uSD Socket 

 

 

Analog Shield 

 
13 Inputs: 

 
8 Outputs: 

 

 
13 Digital inputs, 6 of which can work as Analog Input  
 
8 Digital Outputs, 3 of which can work as Analog Output 
 
 

Relay Shield 

 
6 Inputs: 

 
11 Outputs: 

 
6 Digital Inputs, 4 of which can work as Analog Input 
 
8 Relay Outputs 
3 Digital Outputs, 3 of which can work as Analog Output 
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1.6 Mechanical dimension 

 

 

 

 

*NOTE: This device includes one 2.4GHz antenna and one 5G antenna (for the 5G option), and 

both have a length of 5cm.   
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1.7 General Features 

ESP32 ETHERNET&WIFI&BLUETOOTH PLC FAMILY  

MODEL TYPE Controller General Specifications Information 

Input Voltage 
12 to 24Vdc 

Fuse protection (2.5A) 
Polarity protection 

 

Input rated voltage 
24 Vdc 

  

Rated Power 30 W  

I max. 1.5A  

Size Consult the 1.6 Mesure Table section  

Clock Speed External: 240 MHz   Internal: 8 MHz  

External Flash 
Memory 

4 MB  

SRAM 520 KB  

ROM 448 KB  

Communications 
I2C  –  Ethernet Port – WiFi – BLE – USB – RS485 – 

RS232 – SPI 
Max232-Max485-W5500 

USB consideration! 
Only meant for uploading or debugging, not 

always connected as a serial in a project! 
Cannot be working in a final 

application 

An/Dig Input 10bit 
(0-10Vcc) 

0 to 10Vac 
Input Impedance: 39K 

Separated PCB ground 
Rated Voltage: 10Vac 

 
5 to 24Vdc 

I min: 2 to 12 mA 
Galvanic Isolation 

Rated Voltage: 24 Vdc 
  

 

Digital Isolated Input 
(24Vcc) 

5 to 24Vdc 
I min: 2 to 12 mA 
Galvanic Isolation 

Rated Voltage: 24 Vdc 
  

 

* Interrupt isolated 
Input HS (24Vcc) 

5 to 24Vdc 
I min: 2 to 12 mA 
Galvanic Isolation 

Rated Voltage: 24Vdc 
  

 

Analog Output 8bit 
(0-10Vcc) 

0 to 10Vac 
I max: 20 mA 

Separated PCB ground 
Rated Voltage: 10Vac  

 

Digital Isolated 
Output (24Vcc) 

5 to 24Vdc 
I max: 70 mA 

Galvanic Isolation 
Diode Protected for Relay 

Rated Voltage: 24Vdc 
  

Imax 24Vdc: 410 mA 

Relay Output (220Vac) 

220V Vac 
I max: 5A 

Galvanic Isolation 
Diode protected for Relay 
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PWM Isolated Output 
8bit (24Vcc) 

5 to 24Vdc 
I max: 70 mA 

Galvanic Isolation 
Diode Protected for Relay 

Rated Voltage: 24Vdc  

 

Expandability I2C - 127 elements   -  Serial Port RS232/RS485  

* By using this type of signal can no longer use Digital signal 
(24Vdc) 

 



  Rev. 1: 13-04-2021 
 

18 
 

 Technical Specifications: 

2.1 General Specifications: 

Item ESP32 ETHERNET&WIFI&BLUETOOTH PLC 

Power supply 
voltage 

DC power supply    12 to 24Vdc  

Operating 
voltage range 

DC power supply 11.4 to 25.4Vdc 

Power 
consumption 

DC power supply 30W max. 

External 
power supply 

Power supply 
voltage 

24Vdc 

Power supply 
output capacity 

700Ma 

Insulation resistance 20MΩ min.at 500Vdc between the AC terminals and the protective earth terminal. 

Dielectric strength 
2.300 VAC at 50/60 Hz for one minute with a leakage current of 10mA max. Between all the 
external AC terminals and the protective ground terminal. 

Shock resistance 80m/s2 in the X, Y and Z direction 2 times each. 

Ambient temperature (operating) 0º to 60ºC 

Ambient humidity (operating) 10% to 90% (no condensation) 

Ambient environment (operating) With no corrosive gas 

Ambient temperature (storage) -20º to 60ºC 

Power supply holding time 2ms min. 

Weight See the measure table. 

 
 

2.2 Performance Specification: 

Board ESP32-WROOM-32UE  

Control method Stored program method 

I/O control method Combination of the cyclic scan and immediate refresh processing methods. 

Programming language 
Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform 
composed of a programming language. (We recommend minimum version 1.8.13). 
http://arduino.cc/en/Tutorial/HomePage 

Microcontroller ESP32 

External Flash Memory 4MB 

Program capacity (SRAM) 520KB 

http://arduino.cc/en/Tutorial/HomePage
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SRAM in RTC 16KB 

Clock Speed 40MHz 

 

2.3 Symbology 

Table that includes all the symbology that is used in the serigraph of the ESP32 

ETHERNET&WIFI&BLUETOOTH PLC 

 I/Os Analog/Digital PLUS: 

Symbol 
 

Standard No. / 
Standard Title 

 

Standard 
Reference No. / 

Symbol Title 

Symbol Meaning 

 

IEC 60417 / 
Graphical symbols 

for use on 
equipment 

5031 / Direct 
Current 

Indicates that the equipment is 
suitable for direct current only; 
to identify relevant terminals 

 

IEC 60417 / 
Graphical symbols 

for use on 
equipment 

 

5032 / Alternating 
Current 

Indicates that the equipment is 
suitable for alternating current 

only; to identify relevant 
terminals 

 

 IEC 60417 / 
Graphical symbols 

for use on 
equipment 

 

5130 / Pulse 
General 

To identify the control by 
which a pulse is started. 

 

 IEC 60417 / 
Graphical symbols 

for use on 
equipment 

 

5017 / Earth, 
Ground 

To identify an earth (ground) 
terminal in cases where 

neither the symbol 5018 nor 
5019 is explicily required. 

 

 

IEC 60417 / 
Graphical symbols 

for use on 
equipment 

 

5115 / SIgnal lamp To identify the switch by 
means of which the signal 

lamp(s) is (are) switched on or 
off. 

 

Medical Devices 
Directive 

93/42/EEC 

CE Marking CE marking indicates that a 
product complies with 

applicable European Union 
regulations 

 
 

ISO 7000/ 
Graphical symbols 

for use on 
equipment 

 

0434B / 
Warning symbol 

Indicates a potentially 
hazardous situation which, if 
not avoided, could result in 

death or serious injury 
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 ISO 7000/ 
Graphical symbols 

for use on 
equipment 

 

5036 / Dangerous 
Voltage 

To indicate hazards arising 
from dangerous voltages 

 

 Precautions 

Read this manual before attempting to use the ESP32 ETHERNET&WIFI&BLUETOOTH PLC and 
follow its descriptions for reference during operation. 

3.1 ESP32 Board 

This version of 10 I/Os Digital Module PLCs include ESP32 Board as controller.  

3.2 Intended Audience 

This manual is intended for technicians, which must have knowledge on electrical systems. 

3.3 General Precautions 

The user must operate ESP32 ETHERNET&WIFI&BLUETOOTH PLC according to the 

performance specifications described in this manual. 

Before using ESP32 ETHERNET&WIFI&BLUETOOTH PLC under different conditions from what 

has been specified in this manual or integrating ESP32 ETHERNET&WIFI&BLUETOOTH PLC to 

nuclear control systems, railroad systems, aviation systems, vehicles, combustion systems, 

medical equipment, amusement machines, safety equipment and other systems, machines, 

and equipment that may have a serious influence on lives and property if used improperly, 

consult your INDUSTRIAL SHIELDS representative. Ensure that the rating and performance 

characteristics of ESP32 ETHERNET&WIFI&BLUETOOTH PLC are sufficient for the systems, 

machines, and equipment, and be sure to provide the systems, machines, and equipment 

double safety mechanisms. This manual provides information for programming and operating 

the ESP32 ETHERNET&WIFI&BLUETOOTH. 

 

 Software interface 

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C 

language. They can also be programmed using directly C but it is much easier working with 

Arduino IDE as it provides lots of libraries that helps in the programming.   

Industrial Shields provides boards for programming the PLCs much easier. Basically, it is no 

needed to define the pins and if that pins are inputs or outputs. Everything is set up 

automatically if using the boards. 

In order to install Industrial Shields boards, these are the steps that must be followed. 
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Requirements: 

Arduino IDE 1.8.13 or above (better to have always the latest version). 

 

Steps: 

1. Open Arduino IDE and go to: “File -> Preferences” located in the top left corner. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. In Additional Boards Manager URLs write the following: 

http://apps.industrialshields.com/main/arduino/boards/package_industrialshields_index.json 

3. Press OK to save the changes. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://apps.industrialshields.com/main/arduino/boards/package_industrialshields_index.json
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4. Tools -> Board: … -> Boards Manager. Search for the industrialshields-esp32 board and 

install the last version (it must be from the version 1.0.4 minimum): 

 

 

 

Following these steps, you will be able to see now the Industrial Shields Boards: 
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Once it is selected the ESP32 PLC Family, an extra option will appear on Tools: 

There, it can be selected the exact model for every family. 

Also, there are some examples of programming in File -> Examples -> ESP32 PLC Family 

Furthermore, there are some extra libraries that can be found in Industrial Shields github. 

https://github.com/IndustrialShields/ 

 

 How to connect PLC Arduino to PC 

 

- Connect micro-USB port from PLC to PC.  

NOTE:  
ESP32 ETHERNET&WIFI&BLUETOOTH PLC  
uses micro-USB cable.  
 
 
 

- Open Arduino IDE interface: 
 

- Select Industrial Shields boards -> ESP32 PLC Family 
 

- Select the correct ESP32 PLC Model: 
 

 
 
 

 
- Select correct port for your board. 

 

https://github.com/IndustrialShields/
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 How to connect PLC to power supply 

- ESP32 ETHERNET&WIFI&BLUETOOTH PLC is 12-24Vdc supplied. IMPORTANT: The 

polarity IS NOT REVERSAL!  

- Make sure that the live and GND connector of the power supply match the PLC. 

- Make sure that the power supply mains output is not higher than 24Vdc. 

 

  

- Suggested power suppliers

 

 

The standard, Part 1 of IEC 61010, sets the general safety requirements for the following types 

of electrical devices and their accessories, regardless of where use of the device is intended.  

The equipment must be powered from an external power source in accordance with IEC 

61010-1, whose output is MBTS and is limited in power according to section 9.4 of IEC 61010-

1. 

WARINING: Once the equipment is installed inside an electrical cabinet, the MTBS cables of 

the equipment must be separated from the dangerous voltage cables. 

 

 

Compact DIN rail power supply. Assembled on 35mm 

DIN Rail: 

-12Vdc / 24Vdc 

-2.5A 

-30W 

 

Industrial Shields power supplies provide parallel 

operation, overvoltage protection, and overcurrent 

protection. There is a LED inductor for power status, 

the power supply is certified according to UL. 
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 ESP32 ETHERNET&WIFI&BLUETOOTH PLC Pinout 

7.1 I/Os Table 
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7.2 0 Zone connection 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

   

 

 

 

 

 

 

 

 

Base 
(common unit) 

A Zone 

P
L

C
 

F
u

n
c
ti
o

n
 

3.3Vdc 
5Vdc 
GND 

3.3Vdc 
5Vdc 
GND 
SCL 
SDA 
GND 
IO33 
TX 
RX 

GND 
GND 
VN 
VP 
B- 
A+ 

GND 
50 SO 
51 SI 

52 SCK 
NC 

5Vdc 
GND 
GND 

- 
- 
- 
- 
- 
- 

GPIO 22 
GPIO 21 

- 
- 

TX0 / RS232 
RX0 / RS232 

- 
- 

SENS VN 
SENS VP 

RS485 
RS485 
RS485 

GPIO 19 
GPIO 23 
GPIO 18 

- 
5V 

Gnd 
Gnd 

Base 
(common unit) 

A Zone 

P
L

C
 

F
u

n
c
ti
o

n
 

Vdc 
GND 

Power Supply 
GND 

 
 
 
 
 
 
 
Communication Pins 
 
 
 
 
 
 
 
 
 
 

Configuration Switch* (see section 8 for 
configuring the communications. 
Enabling communications disables some 
I/Os) 
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7.3 Analog/Digital Zone connection (I/Os) 

 

 

 

  

 

 

 

 

 

 

   

 

 

 

 

  

 

 

  

 

 

  

 

 

 

 
1 See the Interrupt Equivalence Table. 
2 See Section 8 to select the correct configuration for outputs. 

X Zone 

R
a
s
p

b
e

rr
y
 

P
L

C
 

C
o

n
n

e
c
to

r 

F
u

n
c
ti
o

n
  

IX.12 
IX.11 
IX.10 
IX.9 
IX.8 
IX.7 

(-)IX.6 

IX.6/INT1 
(-)IX.5 

IX.5/INT1 
(-)IX.4 
IX.4 

(-)IX.3 
IX.3 

(-)IX.2 
IX.2 

(-)IX.1 
IX.1 

(-)IX.0 
IX.0 

Analog / Digital In 
Analog / Digital In 
Analog / Digital In 
Analog / Digita In 
Analog / Digital In 
Analog / Digital In 

GND I0.6 

Interrupt X In 
GND I0.5 

Interrupt X In 
GND I0.4 

Digital Input 
GND I0.3 

Digital Input 
GND I0.2 

Digital Input 
GND I0.1 

Digital Input 
GND I0.0 

Digital Input 

X Zone 

R
a
s
p

b
e

rr
y
 

P
L

C
 

C
o

n
n

e
c
to

r 

    

F
u

n
c
ti
o

n
  

GND 
AX.72 
AX.62 
AX.52 
Q/Vdc 
COM(-) 
QX.72 
QX.62 
QX.52 
QX.4 
QX.3 
QX.2 
QX.1 
QX.0 

GND 
Analog Out 
Analog Out 
Analog Out 

External Isolated Out Vdc 
External Isolated Out GND 

Digital/PWM Out 
Digital/PWM Out 
Digital/PWM Out 

Digital Out 
Digital Out 
Digital Out 
Digital Out 
Digital Out 

 
Analog / Digital Inputs 
 
 
Digital / Interrupt Inputs (isolated) 
 
 
 
 
Digital Inputs (isolated)  
 

 

Led indicator I/Os state 

 
 
Configuration Switch  
(See Section 8 to select the correct 
configuration for outputs) 
 
 
 
 
 
 
 
 
Analog Outputs 
 
Voltage Supply/Reference for 
 
Digital/PWM Outputs (isolated) 
 
 

Top Zone 
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7.4 Relay Zone connection (I/Os) 

 

 

 

  

 

 

 

 

 

 

   

 

 

 

 

 

  

 

 

 

  

 

 

 

 

 
3 See Section 8 to select the correct configuration for outputs. 
4 See the Interrupt Equivalence Table. 

X Zone 

M
-D

u
in

o
 

C
o

n
n

e
c
to
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 F

u
n
c
ti
o
n
 

RX.8 
RX.7 
RX.6 
RX.5 
RX.4 
AX.23 
AX.13 
AX.03 
GND 
QX.23 
QX.13 
QX.03 

GNDCOM 
24VCOM 

Relay Out 
Relay Out 
Relay Out 
Relay Out 
Relay Out 
Analog Out 
Analog Out 
Analog Out 

GND  
Digital/PWM Out 
Digital/PWM Out 
Digital/PWM Out 

External Isolated Out GND 
External Isolated Out Vdc 

 

C Zone 

M
-D

u
in

o
 

C
o

n
n

e
c
to

r 

      

F
u

n
c
ti
o

n
  

RX.3 
RX.2 
RX.1 
GND 
IX.5 
IX.4 
IX.3 
IX.2 

IX.1/INT4 
(-)IX.1 

IX.0/INT4 
(-)IX.0  

Relay Out 
Relay Out 
Relay Out 

GND 
Analog/Digital Input 
Analog/Digital Input 
Analog/Digital Input 
Analog/Digital Input 

Interrupt X In 
GND I0.1 

Interrupt X In 
GND I0.0 

 

Led indicator I/Os state 

 
 
Relay Outputs 
 
 
 
 
 
 
 
 
Analog Inputs 
 
Interrupts/Digital Inputs (Isolated) 
 
Configuration Switch  
(See Section 8 to select the correct 
configuration for outputs) 
 

Top Zone 

Relay Outputs 
 
 
 
 
 
 
Analog Outputs 
 
 
PWM/Digital Outputs 
 

 

NC 
NC 
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7.5 Interrupt equivalence table 

ZONE ANALOG/DIGITAL RELAY RASPBERRY PIN 

A 
0.5 0.0 GPIO27 

0.6 0.1 GPIO26 

B 
1.5 1.0 GPIO35 

1.6 1.1 GPIO25 

C 
2.5 2.0 GPIO34 

2.6 2.1 GPIO5 

 

 

 Switch Configuration 

8.1 0 Zone: Communications  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

USB/RS232: Changing between USB / RS232. If this switch is ON, it enables RS232 

communication and disables the Programming USB. If this switch is OFF, it disables RS232 

communication and enables the Programming USB. (Programming USB must be activated to 

upload programs to the PLC).  

 

Switch  

 ON OFF 

A ZONE 

NC/NC NC NC 

NC/NC NC NC 

NC/NC NC NC 

USB/RS232 RS232 USB 
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8.2 Analog / Digital Zone 

ZONE A  ZONE B  ZONE C 

SWITCH ON OFF  SWITCH ON OFF  SWITCH ON OFF 

NC - -  NC - -  NC - - 

Q0.7 Q0.7 A0.7  Q1.7 Q1.7 A1.7  Q2.7 Q2.7 A2.7 

Q0.6 Q0.6 A0.6  Q1.6 Q1.6 A1.6  Q2.6 Q2.6 A2.6 

Q0.5 Q0.5 A0.5  Q1.5 Q1.5 A1.5  Q2.5 Q2.5 A2.5 

 

8.3 Relay Zone 

ZONE A  ZONE B  ZONE C 

SWITCH ON OFF  SWITCH ON OFF  SWITCH ON OFF 

NC - -  NC - -  NC - - 

Q0.2 Q0.2 A0.2  Q1.2 Q1.2 A1.2  Q2.2 Q2.2 A2.2 

Q0.1 Q0.1 A0.1  Q1.1 Q1.1 A1.1  Q2.1 Q2.1 A2.1 

Q0.0 Q0.0 A0.0  Q1.0 Q1.0 A1.0  Q2.0 Q2.0 A2.0 

 

For the Analog Shield if a switch is set to ON, it can only act as Digital Output. If it is set to OFF, 

it can only act as an Analog Output. 

If it is desired to use a Digital Output the pin must be set to ON and the pin that will provide 

this digital output is represented with QX.X, being X any number of the tables above. 

If it is desired to use an Analog Output the pin must be set to OFF and the pin that will provide 

this analog output is represented with AX.X, being X any number of the tables above. 
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 I/O ESP32 PLC 3.3V pins 

The ESP32 ETHERNET&WIFI&BLUETOOTH PLC has some of the ESP32 board pins available.  

These pins can be programmed according to Raspberry features such as I/O’s operating at 3.3V 

or any additional features present in the pins (for example I2C communication in pins SCL and 

SDA). As these pins are directly connected to the ESP32 board, they are not as well protected 

as the normal inputs. These pins are mainly meant to be used as prototyping. 

The Raspberry board available pins are summarized in the table below. In order to access to 

these pins some extra considerations must be taken in consideration. 

 

 

 

 

 

*IMPORTANT: Do not connect the terminals in the chart above to voltages higher than 3.3V. 

These terminals provide direct access to the ESP32 board. 

There are some special conditions depending on these 3.3V. Now it is going to be shown the 

considerations to operate with these pins. 

 

9.1 I2C 

I2C communication DOES NOT REQUIRE a pull-up resistor for the ESP32 

ETHERNET&WIFI&BLUETOOTH PLC. The pull-up resistor is already implemented in the PCB.  

 

9.2 SPI – MISO/MOSI/SCK 

The ESP32 ETHERNET&WIFI&BLUETOOTH PLC pins used for the SPI bus are summarized in the 

table below. For SPI bus MISO, MOSI and CLOCK pins are common to all the connected devices 

to the ESP32 ETHERNET&WIFI&BLUETOOTH PLC, conversely, each of the connected devices 

will have a single and dedicated SS pin.  

Function PLC connection 

MISO  S0 

MOSI  SI 

CLOCK SCK 

 

 

PLC terminal ESP32 pin 

VN SENS VN 

VP SENS VP 

MISO  GPIO 19 

MOSI  GPIO 23 

SCLK  GPIO 18 

IO33 GPIO 33 

SCL GPIO 22 

SDA GPIO 21 
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 A Zone Features: Communications & RTC & uSD 

10.1 RS-232 

For the RS-232 communication protocol there is a switch that affects it. See the Section 8 for 

more information. If the RS-232 is being used, the Serial0 will be able disabled and not being 

able for transmission nor a debug option.  

Using the boards of Industrial Shields, there is a library that simplifies the RS-232 

implementation. 

10.2 RS-485 (Half Duplex) 

The RS-485 protocol will be always enabled. 

Using the boards of Industrial Shields, there is a library that simplifies the RS-485 

implementation. 

10.3 Ethernet 

ESP32 ETHERNET&WIFI&BLUETOOTH PLC Ethernet port controller is based on w5500 IC, which 

is the compatible IC compatible with Arduino Ethernet2 Shield libraries. All Ethernet shield 

Arduino libraries are compatible with the ESP32 ETHERNET&WIFI&BLUETOOTH PLC.  

10.1 BLE 

This device has got Bluetooth Low Energy provided by the ESP32. It uses the 4.2 BR/EDR 

version and BLE. The BLE is optimized for short burst data transmission, it uses the 2.4GHz ISM 

Band, 40 channels (w/ 2MHz spacing), the channel usage method of FHSS, the GFSK 

modulation. It has a power consumption of ~0.01x to 0.5x of reference (it depends on specific 

usage). It can be used on different network topologies: mesh, broadcast and point-to-point.  

10.2 RTC 

ESP32 ETHERNET&WIFI&BLUETOOTH PLC RTC Module is based on the DS1307 Chip. This chip 

works with the I2C protocol communication, so it is required to have enabled the I2C protocol.  

Using the boards of Industrial Shields, there is a library that simplifies the RTC implementation 

called RTC. 

10.1 I2C pins – SDA/SCL 

The I2C protocol is meant to work in a pull-up configuration. A pull-up configuration means 

that when the pin is at rest (nothing connected to it) it always reads a HIGH value. In this case 

it reads 3.3V when nothing is connected. The pull-up configuration is stablished by default in 

these pins. 

 If it is meant to work them as a GPIO at 3.3V, it must be considered that they are pull-up 

inputs. 



  Rev. 1: 13-04-2021 
 

34 
 

 

10.2 SPI – MISO/MOSI/SCK 

These pins can only work as a 3.3V if the Ethernet protocol is not going to be used. As the 

Ethernet protocol uses the SPI to communicate with the Arduino board, both behaviours 

cannot happen at the same time as the Ethernet would not work. 

These pins are not stablished with a pull-up or a pull-down configuration. The state of these 

pins is unknown. If these pins must be used, they require a pull-up or a pull-down 

configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not, it 

must be stablished an external pull-up or pull-down circuit in order to correctly work with 

these pins.    

10.3 uSD 

The microSD uses the SPI communication to interact with the ESP32. The SPI protocol is always 

enabled, as there are no switches that configure it.  

Using Industrial Shields’ boards there is a library that simplifies the uSD implementation called 

SD. 

The microSD uage is conditioned by the switch configuration. See the Section 8. 

 

  Verify that the CPU is not actively running a process before inserting the memory card.  

Inserting a memory card will cause the CPU to go to STOP mode, which could affect the 

operation of an online process or machine. Unexpected operation of a process or machine 

could result in death or injury to personnel and/or property damage. Before inserting a 

memory card, always ensure that the CPU is offline and in a safe state. 

 

  Vérifiez que le processeur n'exécute pas activement un processus avant d'insérer la 

carte mémoire. 

Si vous insérez une carte mémoire, la CPU passe en mode STOP, ce qui peut affecter le 

fonctionnement d'un processus ou d'une machine en ligne. Le fonctionnement inattendu d'un 

processus ou d'une machine peut entraîner la mort ou des blessures corporelles et / ou des 

dégâts matériels. Avant d'insérer une carte mémoire, assurez-vous toujours que la CPU est 

hors ligne et en sécurité. 

 

 Additional Features 

11.1 5G Wi-Fi 
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The devices of the ESP32 Ethernet & WiFi & BLE PLC controller family have an integrated 5GHz 

Wi-Fi specific chip, called ISM43340. As you may know, the 5GHz Wi-Fi band is an improved 

version of the previous ones, such as the 2.4GHz band, for example. 

The 5GHz technology has some advantages compared to the 2.5GHz band, such as 25 non-

overlapping channels, less interference, faster connection speed, and it works with the 

updated IEEE standards (802.11a, 802.11n, 802.11ac). 

In order to work with it, Industrial Shields offers some example codes located at File -> 

Examples of the Arduino IDE after downloading our boards. 
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 Equivalence Table  

The Digital/Analog I/Os of this device are connected to the ESP32 through I2C, using specific 

chips (see the Section 13). Here we have the equivalence tables (using Industrial Shields 

libraries, we do not have to consider these equivalences): 

12.1 Pin-Out 

12.1.1 Analog/Digital Devices Analog I/Os 
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12.1.2 Digital I/Os  
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12.1.3 Relay Devices Analog I/Os 

 

 

 

 

 

 

 

 

 

 

 

12.1.4 Digital I/Os 
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12.1.5 Relay 
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 Internal I2C and SPI Connections  

 

 

 

 Instructions: How to upload a program 

With these family devices, we must follow a certain protocol to successfully upload a program:  

• Connect the microUSB cable to the microUSB port: 

 

• Configure this switch (BOOT) in ON position: 
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• Upload the code. 

• Once the code is uploaded, turn OFF the previous switch. 

 

 

• Pulse the RESET button: 
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 Instructions for interconnection between Industrial Shields 

controllers  

 

15.1 RS-232 Communication:  

 

15.2 RS-485 Communication: 

15.2.1.1 Half Duplex  
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15.3 Ethernet 

 

For an Ethernet communication between Industrial Shields equipment a SFTP CAT-6 Ethernet 

crossover cable must be used. 
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 Typical Connections 
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 Connector details: 

 

The connector inside the PLCs that mounts on the PCB is  MC 0,5/10-G-2,5 THT – 1963502 

from Phoenix contact. MC0,5/10-G-2,5THT  

For I/O and power supply there is a FK-MC 0,5/10-ST-2,5 - 1881406 connector from Phoenix 

contact. FK-MC 0,5/10-ST-2,5 

 

Connection details: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Article reference MC 0,5/10-G-2,5 THT 

Height 8,1mm 

Pitch 2,5mm 

Dimension 22,5mm 

Pin dimensions 0,8x0,8mm 

Pin spacing 2,50mm 

Article reference FK-MC 0,5/10-ST-2,5 

Rigid conduit section min. 0,14 mm² 

Rigid conduit section max. 0,5 mm² 

Flexible conduit section min. 0,14 mm² 

Flexible conduit section max. 0,5 mm² 

Conduit section AWG/kcmil min. 26 

Conduit section AWG/kcmil max. 20 

https://www.phoenixcontact.com/online/portal/us?uri=pxc-oc-itemdetail:pid=1963502&library=usen&tab=1
https://www.phoenixcontact.com/online/portal/us?uri=pxc-oc-itemdetail:pid=1881406&library=usen&tab=1#General
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 Mechanical Characteristics 

 

- Dimension ESP32 ETHERNET&WIFI&BLUETOOTH PLC: 

 

 

 

 

 

 

 
 
 

- DIN Rail mounting 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
For optimal operation of the product, it must be located in an electrical cabinet with IK08 

mechanical protection. The minimum IP protection degree required is IP56. 
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 Installation and Maintenance 

 
 
Notes for installation: 
 

- The installation position should be free from the following: dust or oil smoke, 
conductive dust, corrosive or flammable gas, high temperature, condensation, and 
rain.  

- Besides, vibration and impact also affect the PLC normal operation and shorten its 
lifespan; electric shock, fire or misact also damages the product. During drilling or 
wiring, prevent the metal particles or wire segments from falling into the PLC casing, 
which may cause fire, fault or misact.  

- After the PLC installation, clean the ventilation duct to prevent blocking, which may 
cause bad ventilation, or even fire, faults or misact.  

- Do not online connect, plug or unplug cables, which is apt to cause electric shock or 
damage the circuit. Installation and wire connection must be firm and reliable. Poor 
connection could cause misact.  

- Use shielded twisted pair for the I/O of high frequency signal and analog signal to 
improve system IMS. 

 
The installation environment should be free from dust, oil smoke, conductive particle, 
corrosive or flammable gases, high temperature, condensation, and rain.  
 
Besides, vibration and impact also affect the PLC normal operation and shorten its lifespan. 
It is recommended to install the PLC, together with the matching switches and contactors, 
in a dedicated electric cabinet and keep the cabinet ventilated. If the location has high 
ambient temperature or heat generating equipment nearby, install forced convection 
devices on top or sides of the cabinet to avoid over-temperature. During drilling or wiring, 
prevent the metal particles or wire segments from falling into the PLC casing, which may 
cause fire, fault or misact. After the PLC installation, clean the ventilation duct to prevent 
blocking, which may cause bad ventilation, or even fire, faults or misact. 
 
The only way to disconnect the equipment from the electrical network is by removing the 
connectors that feed the equipment. Once installed in the electrical cabinet it is very 
important to ensure the power connectors for proper operation. 
 
 

Separate the ESP32 ETHERNET&WIFI&BLUETOOTH PLC from heat, high voltaje and eletrical 
noise: 

 
 
Always separate the devices that generate high voltage and high electrical noise from the 
ESP32 ETHERNET&WIFI&BLUETOOTH PLC. When configuring the layout of the ESP32 
ETHERNET&WIFI&BLUETOOTH PLC inside your panel, consider the heat-generating devices 
and locate the electronic-type devices in the cooler areas of your cabinet. Reducing the 
exposure to a high-temperature environment will extend the operating life of any 
electronic device. Consider also the routing of the wiring for the devices in the electric 
cabinet. Avoid placing low-voltage signal wires and communications cables in the same 
tray with AC power wiring and highenergy, rapidly-switched DC wiring.  
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Provide adequate clearance for cooling and wiring ESP32 ETHERNET&WIFI&BLUETOOTH 
PLC. Is designed for natural convection cooling. For proper cooling, you must provide a 
clearance of at least 25 cm above and below the devices. Also, allow at least 25 cm of 
depth between the front of the modules and the inside of the enclosure. 
 

Notes for maintenance: 
 
A well-planned and executed maintenance program is essential to the satisfactory operation of 
solid-state electrical equipment. The kind and frequency of the maintenance operation will 
vary with the kind and complexity of the equipment as well as with the nature of the operating 
conditions. Maintenance recommendations of the manufacturer or appropriate product 
standards should be followed. 
 
The following factors should be considered when formulating a maintenance program:  
 

- Maintenance must be performed by qualified personnel familiar with the construction, 
operation, and hazards involved with the control.  

-  Maintenance should be performed with the control out of operation and 
disconnected from all sources of power.  

- Care should be taken when servicing electrostatic sensitive components. The 
manufacturer's recommendations for these components should be followed.  

- Ventilation passages should be kept open. If the equipment depends upon auxiliary 
cooling, e.g., air, water, or oil, periodic inspection (with filter replacement when 
necessary) should be made of these systems.  

- The means employed for grounding or insulating the equipment from ground should 
be checked to assure its integrity. 

- Accumulations of dust and dirt on all parts, including on semiconductor heat sinks, 
should be removed according to the manufacturer's instructions, if provided; 
otherwise, the manufacturer should be consulted. Care must be taken to avoid 
damaging any delicate components and to avoid displacing dust, dirt, or debris in a 
way that permits it to enter or settle into parts of the control equipment. 

- Enclosures should be inspected for evidence of deterioration. Accumulated dust and 
dirt should be removed from the top of the enclosures before opening doors or 
removing covers.  

- Certain hazardous materials removed as part of maintenance or repair procedure (e.g., 
polychlorinated biphenyls (PCBs) found in some liquidfilled capacitors) must be 
disposed of as described in Federal regulations. 

 
Safety rules for maintenance personnel 
 

Consider the following steps to follow. A false manoeuvre could be the cause of an 
accident or material damage. 
Do not disassemble or modify the modules. This could lead to breakdowns or 
malfunctions and could lead to injuries or fire. 

 
- All types of radio communication devices, including mobile phones and personal 
handy-phone systems (PHS), must be kept more than 25cm away from the PLC in all 
directions. Failure to observe this precaution exposes malfunctions caused by excess of 
temperature. 
- Disconnect the external power supply of the system (on all phases) before connecting 
or disconnecting a module. Failure to observe this precaution may cause faults or 
malfunctions of the module. 
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- Tighten the screws of the terminal ports and the screws of the connectors within the 
prescribed tightening torque. Insufficient tightening can lead to loose parts or wires 
and cause malfunctions. Excessive tightening can damage the screws and / or the 
module, with the risk of falling, short circuits and malfunctions. 
- Before handling a module, dispose of the electrostatic charge accumulated by the 
human body by touching a suitable conductive object. Failure to observe this 
precaution may cause faults or malfunctions of the module. 

 
Repair note: 
 

If the equipment is suitable to be repaired, it must be verified that the equipment 
remains in a safe state after repair. 
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 Revision Table 

 
 

Revision Number Date Changes 

0 01/03/2021 First implementation 

1 13/04/2021 Changes on the section 11 

   

   

   

   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
About Industrial Shields: 
 
Direction: Fàbrica del Pont, 1-11 

Zip/Postal Code: 08272  

City: Sant Fruitós de Bages (Barcelona)  

Country: Spain 

Telephone: (+34) 938 760 191 / (+34) 635 693 611 

Mail: industrialshields@industrialshields.com 
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